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START SEEING THE
BENEFITS OF
REGISTERING TODAY!

Thank you for your TSI instrument purchase. Occasionally, TSI releases
information on software updates, product enhancements and new
products. By registering your instrument, TSI will be able to send this
important information to you.

http://register.tsi.com
As part of the registration process, you will be asked for your comments

on TSI products and services. TSI's customer feedback program gives
customers like you a way to tell us how we are doing.
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Limitation of Warranty and Liability (effective February 2015)
(For country-specific terms and conditions outside of the USA, please visit www.tsi.com.)

Seller warrants the goods, excluding software sold hereunder, under normal use and
service as described in the operator's manual, shall be free from defects in workmanship
and material for twenty-four (24) months, or if less, the length of time specified in the
operator's manual, from the date of shipment to the customer. This warranty period is
inclusive of any statutory warranty. This limited warranty is subject to the following
exclusions and exceptions:

a. Hot-wire or hot-film sensors used with research anemometers, and certain other
components when indicated in specifications, are warranted for 90 days from the
date of shipment;

b.  DustTrak Environmental pump for Models 8540, 8543, 8540-M, 8542-M, and 8543-M
is warranted for two (2) years or 8760 hours, whichever comes first.

c. Parts repaired or replaced as a result of repair services are warranted to be free from
defects in workmanship and material, under normal use, for 90 days from the date of
shipment;

d.  Seller does not provide any warranty on finished goods manufactured by others or on
any fuses, batteries or other consumable materials. Only the original manufacturer's
warranty applies;

e. This warranty does not cover calibration requirements, and seller warrants only that
the instrument or product is properly calibrated at the time of its manufacture.
Instruments returned for calibration are not covered by this warranty;

f.  This warranty is VOID if the instrument is opened by anyone other than a factory
authorized service center with the one exception where requirements set forth in the
manual allow an operator to replace consumables or perform recommended
cleaning;

g. This warranty is VOID if the product has been misused, neglected, subjected to
accidental or intentional damage, or is not properly installed, maintained, or cleaned
according to the requirements of the manual. Unless specifically authorized in a
separate writing by Seller, Seller makes no warranty with respect to, and shall have
no liability in connection with, goods which are incorporated into other products or
equipment, or which are modified by any person other than Seller.

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS
stated herein. NO OTHER EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR
PARTICULAR PURPOSE OR MERCHANTABILITY IS MADE. WITH RESPECT TO
SELLER’S BREACH OF THE IMPLIED WARRANTY AGAINST INFRINGEMENT, SAID
WARRANTY IS LIMITED TO CLAIMS OF DIRECT INFRINGEMENT AND EXCLUDES
CLAIMS OF CONTRIBUTORY OR INDUCED INFRINGEMENTS. BUYER’S
EXCLUSIVE REMEDY SHALL BE THE RETURN OF THE PURCHASE PRICE
DISCOUNTED FOR REASONABLE WEAR AND TEAR OR AT SELLER’S OPTION
REPLACEMENT OF THE GOODS WITH NON-INFRINGING GOODS.

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER OR
BUYER, AND THE LIMIT OF SELLER'S LIABILITY FOR ANY AND ALL LOSSES,
INJURIES, OR DAMAGES CONCERNING THE GOODS (INCLUDING CLAIMS BASED
ON CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR OTHERWISE) SHALL
BE THE RETURN OF GOODS TO SELLER AND THE REFUND OF THE PURCHASE
PRICE, OR, AT THE OPTION OF SELLER, THE REPAIR OR REPLACEMENT OF THE
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GOODS. IN THE CASE OF SOFTWARE, SELLER WILL REPAIR OR REPLACE
DEFECTIVE SOFTWARE OR IF UNABLE TO DO SO, WILL REFUND THE PURCHASE
PRICE OF THE SOFTWARE. IN NO EVENT SHALL SELLER BE LIABLE FOR LOST
PROFITS, BUSINESS INTERRUPTION OR ANY SPECIAL, INDIRECT,
CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER SHALL NOT BE
RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS
OR CHARGES. No Action, regardless of form, may be brought against Seller more than
12 months after a cause of action has accrued. The goods returned under warranty to
Seller's factory shall be at Buyer's risk of loss, and will be returned, if at all, at Seller's risk
of loss.

Buyer and all users are deemed to have accepted this LIMITATION OF WARRANTY AND
LIABILITY, which contains the complete and exclusive limited warranty of Seller. This
LIMITATION OF WARRANTY AND LIABILITY may not be amended, modified or its terms
waived, except by writing signed by an Officer of Seller.

Service Policy

Knowing that inoperative or defective instruments are as detrimental to TSI as they are
to our customers, our service policy is designed to give prompt attention to any
problems. If any malfunction is discovered, please contact your nearest sales office or
representative, or call TSI's Customer Service department at (800) 874-2811 (USA) or
(001 651) 490-2811 (International) or visit www.tsi.com.
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Safety Information

Laser Safety

e Models 8540/8543/8540-M /8542-M /8543-M DustTrak™
Environmental Monitors are Class | laser-based instruments.

o During normal operation, you will not be exposed to laser
radiation.

e Precaution should be taken to avoid exposure to hazardous
radiation in the form of intense, focused, visible light.

e Exposure to this light may cause blindness.

Take these precautions:

e DO NOT remove any parts from the DustTrak Environmental
Monitor unless you are specifically told to do so in this manual.

WARNING

The use of controls, adjustments, or procedures other
than those specified in this manual may result in
exposure to hazardous optical radiation.

WARNING

If the DustTrak monitor is used in a manner not
specified by the manufacturer, the protection
provided by the equipment may be impaired.

When operated according to the manufacturer’s instructions, this
device is a Class | laser product as defined by U.S. Department of
Health and Human Services standards under the Radiation Control
for Health and Safety Act of 1968. A certification and identification
label like the one shown below is affixed to each instrument.



Labels

Advisory labels and identification labels are attached to the

instrument.

1. Serial Number Label (back)

DusTTRAK ™ DRX — Model 8543

SN 8543151401 | “ I ‘ ‘ I
(R
CLASS | LASER PRODUCT

MFD APRIL 2015 |
COMPLIES WITH 21 CFR 1040 10 AND 1040 11

‘3) ( € = 12124V -50\

Made in USA

2. Laser Radiation Label
(internal)

DANGER!
VISIBLE LASER RADIATION WHEN

OPEN. AVOID DIRECT EXPOSURE
TO BEAM

WARNING: NO USER SERVICABLE
PARTS INSIDE. REFER SERVICING
TO QUALIFIED PERSONNEL

3. Calibration Label (back)

® Calibrated

Customer Service 1-800-874-2811
Outside US 001-651-490-2811
www.tsi.com
Date: January 2015

4. |P Label (back)

USB IP Address:
199.254.130.225

5. European symbol for non-
disposable item. Iltem must be
recycled.

I
6. MCERTS Certification Label(s)
77ICERTS 7ICERTS 77ICERTS
Sira MC160316/00 Sira MC160317/00 Sira MC160318/00
EDTPM10M EDTPM2.5M EDTDRXM

vi




Description of Caution/Warning Symbols

Appropriate caution/warning statements are used throughout the
manual and on the instrument that require you to take cautionary
measures when working with the instrument.

Caution

Caution
Failure to follow the procedures prescribed in this
manual might result in irreparable equipment

damage. Important information about the operation
and maintenance of this instrument is included in
this manual.

Warning

WARNING
Warning means that unsafe use of the instrument
could result in serious injury to you or cause

damage to the instrument. Follow the procedures
prescribed.

Caution and Warning Symbols

The following symbols may accompany cautions and warnings to
indicate the nature and consequences of hazards:

Warns that the instrument contains a laser and that
important information about its safe operation and
maintenance is included in the manual.

Warns that the instrument is susceptible to electro-
static discharge (ESD) and ESD protection should be
followed to avoid damage.

Indicates the connector is connected to earth ground
and cabinet ground.

® p> >
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Reusing and Recycling

As part of TSI Incorporated’s effort to have a minimal
negative impact on the communities in which its
products are manufactured and used:

@ Do not dispose of used batteries in the trash.
Follow local environmental requirements for
battery recycling.

@ If instrument becomes obsolete, return to TSI for
disassembly and recycling.

viii



Chapter 1

Product Overview

DustTrak™ Environmental Models 8540, 8540-M, and 8542-M and
DustTrak DRX Environmental Models 8543 and 8543-M Monitors are
data-logging, light-scattering laser photometers that provide real-time
mass concentration readings for aerosol contaminants such as dust,
smoke, fumes and mist. These instruments use a sheath air system
that isolates the aerosol in the optics chamber to keep the optics
clean for improved reliability and low maintenance. These monitors
offer a suitable solution for long-term outdoor monitoring, construction
and environmental clean-up sites.

DustTrak Environmental Monitors (Model 8540,
8540-M, and 8542-M)

The DustTrak Environmental Monitors are continuous, real-time,
single-channel, 90° light-scattering laser photometers that are used to
determine the mass concentration of aerosols. A robust, long-life
pump allows for the use of a variety of size-selective inlet conditioners
to measure aerosol concentrations corresponding to PMio, or PMzss.

DustTrak DRX Environmental Monitors (Model 8543
and 8543-M)

The DustTrak DRX Environmental Monitors are continuous, real-time
light-scattering laser photometers that simultaneously measure size-
segregated mass fraction concentrations corresponding to PMu,
PM2;5, and PMio—something no other monitor can do. The instrument
combines both particle cloud (total area of scattered light) and single
particle detection to achieve mass fraction measurements. This size-
segregated mass fraction measurement technique is superior to
either a basic photometer or optical particle counter (OPC). It delivers
the mass concentration of a photometer and the size resolution of an
OPC.

The DustTrak Environmental Monitors are designed to operate inside
the TSI Environmental Enclosure (Model 854030) which has an
International Protection Marking of IP44. The DustTrak Environmental
Monitor should not be used outdoors without an appropriate weather-
proof enclosure.



Models 8540-M, 8542-M, and 8543-M MCERTS
Certified Monitors

If you are using a DustTrak™ Environmental Monitor Model
EDTPM10M, EDTPM2.5M or EDTDRXM, these Models are designed
and set up to meet MCERTS (Monitoring Certification Scheme)
certification for indicative instruments. The following must be
installed for these model products to meet the MCERTS
Indicative Certification:

EDTPM10M: MCERTS PM10 Indicative Certification

O 0000 Oo

8542-M Photometer

N

854030 Environmental Enclosure .

854040 Omni-directional Inlet w/Water Trap ?ZCMERU
Sira MClSOElS/O’l‘)

854020 PM10 Impactor

854041 Heated Inlet

PCF set at 0.53 (preset at the factory). It is recommended that the
instrument is run with a Photometric Correction Factor (PCF) of
0.53. However, the application of a site specific correction factor
may be used if a significant decrease in the expanded uncertainty
can be demonstrated.
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EDTPM2.5M: MCERTS PM2.5 Indicative Certification
8540-M Photometer

854030 Environmental Enclosure

Y

854040 Omni-directional Inlet w/Water Trap .

e
SiraMC160317/00

854021 PM2.5 Impactor
854041 Heated Inlet

U000 O0Oo

PCF set at 0.33 (preset at the factory). It is recommended that the
instrument is run with a Photometric Correction Factor (PCF) of
0.33. However, the application of a site specific correction factor
may be used if a significant decrease in the expanded uncertainty
can be demonstrated.

EDTDRXM: MCERTS PM10 and PM2.5 Indicative Certification
O 8543-M Photometer

N

854030 Environmental Enclosure . '
/MCERTS

NOMTORING CERTICATION SCHEME

SiraMC160318/00

854040 Omni-directional Inlet w/Water Trap

854041 Heated Inlet

O 0 0 O

PCF PM2.5 set at 0.47, PM10 set at 0.53 (preset at the factory). It
is recommended that the instrument is run with a Photometric
Correction Factor (PCF) of 0.53. However, the application of a
site specific correction factor may be used if a significant
decrease in the expanded uncertainty can be demonstrated.
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Chapter 2

Unpacking and Parts ldentification

Carefully unpack the Model 8540 /8540-M/8542-M /8543 /8543-M
DustTrak™ Environmental Monitor from the shipping container. Use
the tables and illustrations below to make certain that there are no
missing components. Contact TSI immediately if anything is missing

or damaged.

Unpacking the DustTrak Monitor
Compare all the components you received with those listed in the

table below. If any parts are missing, contact TSI.

Item Qty | Part Number | Description
. 1 8540 DustTrak
‘I 8540-M Environmental
) L : ; 8542-M Monitor
‘ l 8543 DustTrak DRX
3 8543-M Environmental
. Monitor
1 1090014 Data Analysis
Software CD-ROM
& 1 1303740 USB cable
S S
=
~a
~
1 801856 24V DC power

supply
Included only when
8540-WPS or

8543-WPS is
ordered




Item Qty | Part Number | Description

1 6008408 Operation and
Service Manual

3
=

N/A Calibration
Certificate

BiAtyiey

OO ]

R BRLR

T
A O

User Replaceable Internal Parts

Item ‘ Part Number ‘ Description
854044 Sheath Air Filter
=
854043 Pump
NA 37-mm, 2-piece,
static conductive
cassette

Blank replacement cassettes or media can be ordered from
www.zefon.com.
37-mm 2-piece blank cassette product # 37MMH-2-CF

Zefon can also supply pre-weighed filter media for gravimetric sampling.

Chapter 2
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Optional Accessories

ltem Part Number Description
Y 854030 Environmental
1T| Enclosure
H
x 1 - See 854030
s ‘ manual for
' L enclosure
: { accessory options
801905 Netronix™
Thiamis™ 1000
Communication
Node
Y 854040 Omni-directional
i Inlet w/Water Trap
Bottle
!,
L — - . 854041 Heated Inlet
8 < (\\. Sample Conditioner
‘/\ -
s )
= 854034 Enclosure Power

¥

C;-

Supply

Unpacking and Parts Identification




Item Part Number | Description

‘ 854042 Water Trap Bottle

¥

Y 854020 PMa1o Impactor

[ o)

’ﬁ Sud e
H g { ~‘ 854021 PMz.s Impactor
‘ 854022 PMz1.0 Impactor

Parts Identification for the DustTrak Environmental
Models 8540/8540-M /8542-M /8543 /8543-M

"\ Inlet

<+—— Analog/Alarm

<+—— USB Host
<+—— USB Device

Ethernet
Power Power and
Button RS-232
Communication
for Heated Inlet
Service Accessory
Panel Power

Figure 1: Features on Models 8540/8540-M/8542-M/8543/8543-M
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X #5-32 THD
_+_ ¥ 230 MIN FULL THD DEPTH
=] =]

o #_r

5975

o
_+__L
o

1625

+ i
!-. 2X7200 }-— 2X 400

Figure 2: Back panel interface control dimensions

1.225

Figure 3: View of back panel with mounting holes shown

Holes are pre-drilled in the back of the photometer to enable users to
develop their own mounting bracket for attaching the photometer into
an alternate enclosure.

Mounting the photometer using these holes will need quantity four (4)

#6-32 screws that penetrate no deeper than 0.230” into the back
panel of the photometer.

Unpacking and Parts Identification 9
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Chapter 3

Setting Up

Environmental Enclosure

The DustTrak Environmental Monitor is designed to be mounted
inside in the environmental enclosure. The TSI 854030 Environmental
Enclosure has been designed specifically to protect the DustTrak
Environmental Monitor and its accessories. See Environmental
Enclosure Model 854030 Operation and Maintenance Manual

(P/N 6008410) for more details and installation instructions.

rs)

Figure 4: Environmental Enclosure

11



Supplying Power to the DustTrak Environmental
Monitor

One method for supplying power to the instrument is to use the 24V
power supply (TSI P/N 801856). Simply fasten the barrel connector to
the instrument as shown in Figure 5. This power supply (and a region
specific power cord) is included if model numbers 8540-WPS or
8543-WPS are ordered. This power supply is mainly used to power
the instrument when it is not mounted inside of the enclosure and
communication is required for diagnostics and programming.

WARNING

DO NOT connect the optional Thiamis 1000
accessory (TSI P/N 801905) to the instrument
when using this 24V power supply. Damage to the
modem will occur.

Figure 5: Instrument power connection

If the instrument is installed into the 854030 Environmental
Enclosure, power options include AC Power Supply (854034), AC
power supply included with enclosure heater (854033), Rechargeable
Battery Power System (854036), and Solar Power System (854060).

12 Chapter 3



Omni-directional Inlet Column

Optional accessory 854040

See the Quick Start Guide installing impactors PM1o0 (854020), PM2s
(854021), PM1 (854022) onto the omni-directional inlet for details.

Figure 6: Inlet, water trap and base with connection rings

Zero Calibration of Instrument

The DustTrak Environmental Monitor has the ability to automatically
“Zero” the instrument readings at programmed intervals. “Zeroing” the
instrument resets the photo detector, to a signal that represents no
particles flowing through the optics. Over time, photometric light-
scattering instrument readings can drift due to changes in temperature
and aerosol build up in the optics. Programming regular “Zero” events
corrects the photometric signal to account for these changes.

The DustTrak Environmental Monitor automatically performs a zero
calibration when the instrument begins any programmed run and the
auto zero function has been enabled. Use the instructions detailed in
Chapter 4 for enabling auto zero and configuring the automatic
interval using the TrakPro software.

Setting Up 13



Instrument Setup and Operation Options

 §

‘*‘ B 2 ®

7

ICERTS

2 =
- - e

Power button

1
S
L]

e )
\

Figure 7: Setting up instrument and operating options

Press the power button to turn on instrument. The button will turn
blue, indicating the instrument has power and is turned on.

To turn instrument off, hold the power button for 10 seconds and then
release. The blue indicator light in the power button will turn off,
indicating the instrument has shut down.

Use the DustTrak Checkout Software or Netronix™ Environet (both
explained below) to read the instrument status, program instrument,
and activate instrument programmed runs.

The DustTrak instrument can be setup and controlled using one of
three options:

e Use TrakPro™ Data Analysis Software to configure instrument,
run instrument and download data. Quick start information for
using TrakPro software is shown in the section below.

e Use a Netronix™ Thiamis™ Communication Node and web-
based application Environet to setup and control the DustTrak
monitor remotely. See Netronix quick start guides for Netronix
installation and set-up.

e Use the DustTrak monitor's command set to develop a custom
program for setting up and controlling the DustTrak monitor. See
the command set information in Appendix B.

14 Chapter 3
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DustTrak Checkout Application

e DustTrak Checkout Application enables a “virtual screen” for the
DustTrak monitor. Instrument data, flow calibration, zero
calibration, instrument diagnostics, etc., can be viewed or
performed through the use of the checkout software.

e This software can be used as part of your field installation
process to ensure the instrument is functioning properly, when
Netronix™ is not being used or a web accessed device is not
immediately available during field installation.

Open DustTrak Checkout executable file and follow the steps to run

the installation wizard.

e The DustTrak Checkout Application can also be
downloaded from the TSI website. Visit
http://www.tsi.com/Software-Firmware/ and click on the

Software and Firmware Wizard link. Follow the on-
screen instructions to download the software.

e Your computer must have the current version of
TrakPro software to access the proper drivers to
communicate with this Checkout Application.

Name

‘a' EnvDTCheckoutlnstall.exe

Date modified

2/11/2015 12:41 PM

Type Size

Application

4,038 KB

%! User Account Control W

Do you want to allow the following program to make

changes to this computer?

@,

Program name:  EnvDTCheckoutlnstall
Verified publisher: TSI, Incorporated
File origin: Network drive

Change when these notifications appear

¥/ Show details Yes

=X

5 e Checkoutinstal - InstalSniekd Wizard | e

Welcome to the InstaliShield Wizard for
EnvDTCheckoutInstall

Figure 8: Checkout Application — Setup screen

Setting Up
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DustTrak Checkout Application

After installing the application, plug the provided USB cable into the
“USB B” port on the instrument and plug the other end into your
computer. Power on the instrument and click the Connect button.
The USB IP address and instrument information will appear when
connected.

& Environmental DustTrak Ch ut 1,00,

Connect | Data | Flow | Zero | Laser | Diagnostics | IP Label
InstIP addr  159.254.241.173

Serial Number: 8543150403

Model Number: 8543

Firmware Version: 3.3

Instrument Time: 4/15/2015 6:40:9 [ Set Instrument Date and Time ]
Calibration Date: 1/30/2015
Filter Change Date: 1/30/2015
Cum Mass Conc: 0.314178 Reset Filter Date and Concentrations

Cum Filter Conc: 0

Pump Run Time: 0

Shutdown Instrument

Figure 9: Checkout Application — Connect tab
Click the Data tab to access the current instrument readings.

Clicking the green arrow will start the instrument pump to begin
sampling in Survey Mode. No data will be logged onto the
instruments memory while running in Survey Mode.

& Environmental DustTrak Checkout 1.0.0@@&
e il

Connect Flow | Zero | Laser | Diagnostics | IP Label

Average # reading per second Current Run Mode:  SURVEY
1 |

® s

PML  0.000 . Fow

PM2.5:  0.000

PM4: 0.000 . Laser

PM10:  0.000

Total:  0.000 . Filter

Figure 10: Checkout Application — Data tab

16 Chapter 3



Click on the Flow tab to adjust the pump flow rate.

'8’ Environmental DustTrak Checkout  2.0.0.0 =10 2

Connect | Data | Flow | Zero | Laser | Diagnostics | IP Label | IP Addressing

Start flow then Adjust flow to the desired value.
When done click Save to store the new value.

‘ @‘ Actual Flow (LPM) ‘ Save |

Adjust Flow

v

Flow 1.00

Figure 11: Checkout Application — Flow tab

Click the green arrow to start the pump, allowing for a change to the
flow setpoint. The flow setpoint is factory set to 3 L/min total flow.

2 L/min of the total flow is measured aerosol flow. 1 L/min of total flow
is split off, filtered, and used for sheath flow. There is an internal AP
flowmeter in the DustTrak instrument that controls flow rate to +5% of
the factory setpoint. TSI recommends checking the flows with an
external flow reference meter, especially when collecting data.

1.

Attach a flow calibrator (reference flowmeter) to inlet port. You
may use a bubble buret, mass flowmeter, dry piston or rotameter
as flow measurement devices.

Click on the up or down arrows to achieve desired flow on the
reference flowmeter. Each click of the up or down arrow will
change the flow about 1%. Allow time between button presses to
let pump change to the new flow rate.

Click Save once the desired flow rate is achieved. Select Undo to
return to the factory setpoint.

Note — Models 8540, 8540-M, 8542-M ‘

The flow rate can be adjusted from approximately 1.5 to
4.0 L/min. If needed, this feature can be used to adjust the
flow rate to a value other than the factory setpoint,
allowing for the use with 3 party size selective inlets
(cyclones or impactors) that may require a different

flow rate.
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Note — Models 8543, 8543-M

The flow rate can be adjusted from approximately 1.5 to
4.0 L/min. This feature allows you to re-adjust the flow
rate, if needed, to 3.0 L/min. The flow rate for the DRX
models should remain fixed at 3.0 L/min. No size-selective
inlets or cyclones should be installed on the inlet of the
instrument during its normal operation.

Click on the Zero tab to manually perform a zero calibration for the
instrument. Click Start Zero to start the zeroing process.

The “Last Zero” and “New Zero” values do not represent particle
count or aerosol mass. These values are associated with the signal
received by the photometric sensor when no particles are passing

through the optics.

+® Environmental DustTrak Checkout 1000 0= SR

N e (5 e S

Connect | Data

Last Zero: 1831

Flow | Zero | Laser | Diagnostics

Attach the Zero filter then click the Start Zero button below.

| Start Zero ‘

New Zero: 1832

IP Label

Figure 12: Checkout Application — Zero tab

The Laser tab is only accessible in password-protected “Engineering
Mode.” Changes made to the Laser setting will directly affect the
calibration, the instrument response, and is available only to TSI

technicians.
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The Diagnostics tab opens a command window that can be used to
send instructions to the instrument. Click Send or press the Enter key
to send the command to the instrument. See the Communication
Settings in Appendix B.

-
i

Zero | Laser = Diagnostics iIPLabeI
Command:  [RMMEAS

Response

Connect | Data | Flow

Figure 13: Checkout Application — Diagnostics tab

The IP Label tab opens a printer connection box and displays the
instrument IP address.

ity

FIow‘Zero Laser | Diagnostics = IP Label

Printer Connection: COM1

Connect ‘ Data

Inst IP addr: 169 . 254 217 77

Figure 14: Checkout Application — IP Label tab
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The IP Addressing tab can be used to change the settings for the
instruments Ethernet IP address. After making changes, click Save
for the settings to take effect.

& Environmental DustTrak Checkout  2.0.0.0 (o= =]

Zero ‘ Laser ‘ Diagnostics | IP Label ‘ IP Addressing

Flow

Connect | Data

EThernet IP Addressing Static ~

Current IP Address 192 168 . 8 186
Current Subnet Mask 255 255,255 . 0
Current Gateway 192 168 8 . 2

Figure 15: Checkout Application — IP Addressing
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Chapter 4

TrakPro Software Quick Reference

Connecting to the Computer

The TrakPro software can be used to preprogram the instrument,
download data, view and create raw data and statistical reports,
create graphs, and combine graphs with data from other TSI
instruments that use TrakPro software. Connect the USB host port of
a Microsoft Windows®-based computer to the USB device port on the
side of the DustTrak Monitor.

Installing TrakPro Data Analysis Software

The following sections describe how to install the software and set up
the computer.

To use TrakPro software with the DustTrak Monitor, the
PC must be running Microsoft® Windows® and the
computer must have an available Universal Serial Bus
(USB) port.

1. Insert the TrakPro Data Analysis Software CD into the CD-ROM
drive. The install screen starts automatically.

If the software does not start automatically after a few
minutes, manually run the program listed on the label of
the CD using the Run command on the Windows®
Start Menu.

2. Follow the directions to install TrakPro software.

TrakPro software contains a comprehensive installation guide. TSI
recommends printing out this guide prior to starting the TrakPro
software installation on your computer, so it may be consulted during
the installation. The TrakPro Software manual is located in the “Help”
file in TrakPro software. There is no separately printed TrakPro Data
Analysis software manual.

®Microsoft and Windows are registered trademarks of Microsoft Corporation.
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TrakPro Software Steps

Establishing Communications with the Instrument

Open up TrakPro software and

Instrument Setup |  Options

He

select Instrument Setup ->

| Communications...

Communications.

Radio Comm...

Parameters
Logging Setup...
Legging Control

Calibration...

The software will

NDIS CummunicationsA

~

automatically find the
instrument, as shown in

the dialog. Model

Serial Mumber

Statuz

IP Address

DustTrak DR detected witk 1P 169254241173

8543

|Communicati-:-ns Functioning OF,

8543150403

163 .

284 . 21

Llose

173

Configuring the Logging Parameters

Select Instrument Setup ->
Logging Setup.

Instrument Setup | Options  He

Communications... ;

Radio Comm...

Parameters

Legging Setup...

Lagging Contral

Calibration...

22
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This will open a dialog allowing for the configuration of the different
instrument run modes. The sampling mode options include Survey
mode, Manual Mode and Program Logs 1-5.

Survey Survey Mode runs a real time, continuous active
sample, but does not log data.

Manual Manual Log sets the instrument to log data for a
specified run time.

Log Modes Log Mode starts and stops the instrument at
specified times, run for a specified test length, and
perform multiple tests of the same length with a
specified time period between tests.

Logging Program Setup @1
Serial Mumber: 8543150403 Murnber Tests Logged: 1 Available Memary % 100
Select protocal ta edit IFEEET
MName | SURVEY ?
Stait Date [MhAdd Ay 01,401 /2008 ——————
Send
Start Time [hh:mm]: 0000 = VENW
Log Interval [mm:ss) 0| 0= m
Test Length [dd:kb:mm]: 0 of o
Number of Tests: 0
1 Time Between Testz [dd:hh:mm]: ol ol o : |
I Time Constant: 1 =
: Auto Zemo Enable and Interval (hh:mm]: o o
Percent T otal Memory Reguired: 100
L ———

Press the Read button to get the current log modes
from the instrument.

Update the log modes to meet logging requirements. Details on log
modes are in table below.
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Survey Mode Options

Time Constant

Time Constant can be set from 1 to 60
seconds.

Auto Start on
Power Up

When set to “Yes”, unit will start a
measurement upon being powered on, if the
unit was set to “Survey” when it was turned off.

When set to “No”, the unit will be in idle when it
is powered on.

Manual Mode Options

Log Interval

The log interval can be set from 1 second to 60
minutes. It is the amount of time between
logged data points.

Test Length

Test length can be set from 1 minute to the
limit of the data storage.

Time Constant

Not used for the 8540/8540-M /8542-M /8543 /
8543-M models.

Program Log Opti
Log Name

ons
Enter descriptive name for the log mode.

Start Date

Select the date and the test will start.

Select the check box to use Start Date, option
to use programmed start date, or bypass
programmed start date.

Start Time

Select the time the test will start.

Select the check box to use Start Time, option
to use programmed start time or bypass
programmed start time.

Log Interval

The log interval can be set from 1 second to 60
minutes. It is the amount of time between
logged data points.

Test Length

From 1 minute to the limit of the data storage.

Number of Tests

1 to 999.

Time between
Tests

1 minute to 30 days.

Time Constant

Not used for the 8540/8540-M /8542-M /8543 /
8543-M models.
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Program Log Options

Auto Zero
Interval

Interval between re-zeroing the instrument
using the built in autozero functionality.

Use the check box to enable use of
autozeroings.

Once the log modes have been updated, press
the Send button to send the new log modes to the

instrument.

If using a programmed start time and start date, update the

instrument date and time to ensure the logging starts as planned.

Select Instrument Setup -> Parameters -> Clock to set the time.

Instrument Setup | Options  Help
Communications... st Trak DRX
Radic Cormm...

Parameters Clock...

Logging Setup...
Logging Control

Logging Intervals...

Time Constants...

o DOther...
Calibration...
Analog Output...
Alarm Setpoint...
Clock Setup e
Enter date as 'MM/dd/yyyy' time as hh:mm:ss
or transfer System Time
System Time Instrument Time
01/24/2015 B oyzyis @ Send
13:52:33 > oe:3408 z

TrakPro Software Quick Reference
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Setting User Calibration Factors

In most cases, a user calibration factor of 1 for photometric and size
cal (DRX only) will be sufficient. Use the following instructions to
change the instruments User Cal, if an improved calibration factor is
required.

Set User Calibration Factor allows you to store and use 10 different
calibration factors. In addition, there are preprogrammed factory
defaults, one is the “Ambient Cal” and the other is the “Factory Cal”
(8540-M, 8542-M and 8543-M also have an MCERTS cal). The
“Ambient Cal” is appropriate for outdoor ambient dust or fugitive dust
monitoring. The “Factory Cal” is the calibration to ISO 12103-1, A1
Arizona test dust for which a calibration certificate is provided with the
instrument. The “Factory Cal” is appropriate for most workplace
aerosol monitoring. Factory Cal can be set by simply setting both the
size correction factor (DRX model only) and the photometric
calibration factor to 1.

Use the following steps to get to

. ) Instrument Setup | Options  He
the user cal functionality:

Communications... L

Select Instrument Setup -> Radio Comm...

Calibration.

Parameters 4
Legging Setup..
Legging Control

Calibration...
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Click the Set User Calibration Factor button to access the

instrument calibration settings.

Factary Calibration

Ulger Calibration
Sensor Last Calibrated

Coz Last:

Co: Due:

Temperature:

Hurnidity:

Bt

Aerogal;

S

Calibration Drate:

01,/30/2015
01/30/2016

t Lzer Calibration Fac 3

In this dialog, you can select the factory ambient cal or customizable

user cals 1 through 10, (1 through 9 for MCERTS models 8540-M,
8542-M and 8543-M). User Cals 1 through 10 can be used to set

custom user calibration factors.

F
Instrument Calibration

=

User Calibration Name:

l;]
User Cal 1
Usger Cal 2
User Cal 3
User Cal 4
User Cal 5
User Cal &
User Cal 7
User Cal 8
User Cal 9

Ambient

Mame:

MCERTS

Photometric:
0.530

User Cal [On, Off]:

@ oM () OFF

TrakPro Software Quick Reference
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Four variables can be set for each user calibration.

Name User can input a custom description for the
custom User Calibration.

Photometric Changes the factory calibration of particle

Calibration signal, based on Arizona Road Dust, to actual

Factor aerosol being measured.

Size Calibration | Changes the factory calibration of the particle
Factor distribution, based on Arizona Road Dust, to
actual aerosol being measured. This is for the
DRX only. A setting of 1 works for most
situations.

User Cal [on,off] | Selecting On will activate current user
calibration and deactivate the previously
selected user calibration.

Determining a new Photometric Calibration Factor

In most situations, the DustTrak monitor with its built-in data logging
capability can provide very good information on how the

concentration of an aerosol changes for different processes over

time. Factory calibration to the respirable fraction of standard

ISO 12103-1, Al test dust is fairly representative of a wide variety of
workplace aerosols. Because optical mass measurements are
dependent upon particle size and material properties, there may be
times in which a custom calibration would improve your accuracy for a
specific aerosol.

Determining an aerosol-specific photometric calibration requires that
you determine a true mass concentration (e.g., gravimetric analysis)
for the aerosol you want to measure. The true mass concentration is
used to calculate the custom calibration factor for that aerosol. Once
you have a custom calibration factor, you can reuse it each time you
make measurements in the same aerosol environment.

Determining the Calibration Factor for a Specific Aerosol

The DustTrak monitor is factory calibrated to the respirable fraction of
standard 1ISO 12103-1, Al test dust. The DustTrak monitor can be
easily calibrated to any arbitrary aerosol by adjusting the custom
calibration factor. The DustTrak monitor’s custom calibration factor is
assigned the value of 1.00 for the factory calibration to standard 1SO
test dust. This procedure describes how to determine the calibration
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factor for a specific aerosol. Using the value of 1.00 will always revert
back to the factory calibration.

To determine a new calibration factor you need some way of
accurately measuring the concentration of aerosol, hereafter referred
to as the reference instrument. A gravimetric analysis is often the best
choice, though it is limited to nonvolatile aerosols.

To make an accurate calibration you must simultaneously measure
the aerosol concentration with the DustTrak monitor and your
reference instrument.

1.
2.

Zero the DustTrak monitor.

Put the instrument in Manual Log (Manual Logging is reviewed
later in this section).

Set the logging interval. One minute (i.e., “01:00”) is often a
good choice.

Co-locate the DustTrak monitor and the reference sampler
together so that they are measuring from the same area.

Start sampling aerosol with both instruments at the same time.

Greater accuracy will be obtained with longer samples.
The time you permit for sampling often depends on the
reference instrument and characteristics of the measured
aerosol. It may take some time to collect sufficient aerosol
onto a filter cassette for accurate gravimetric analysis.
Refer to instructions of your reference instrument for
sampling times.

Stop sampling with both instruments at the same time.

Record the DustTrak monitor average concentration by viewing
the sample average by downloading the saved data to
TrakPro software.

Determine the mass concentration in mg/m? from your reference
instrument. For gravimetric sampling this means weighing the
gravimetric sample.
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¢ If you installed a gravimetric filter into the DustTrak
monitor and are; therefore, using the DustTrak monitor
to obtain a gravimetric sample, the flow rate used to
compute the concentration should be 2 L/min, not
3 L/min since only 2 L/min of aerosol flow reaches
the filter.

e To ensure proper fit into the DustTrak gravimetric
holder, TSI recommends using conductive,
polypropylene, 2-piece 37-mm cassette housings.

9. Compute the new calibration constant, NewCal, using the
following formula:

Reference Concentration
DustTrak Concentration

NewCal= ( ) -CurrentCal

10. Enter the new value into one of User Cal [On, Off]:
the custom user cals and turn
that cal “on” using the radio @ ON OFF
button.

Starting a DustTrak Sample Run

Once a log mode is set and a calibration mode selected, the DustTrak
monitor can be started using TrakPro software. To start a sample,
perform the following steps.

First select Logging Control Instrument Setup | Options  H

Select Instrument Setup -> Communications...
Logging Control. 9

L=

Radio Comm...

Parameters 4

Legging Setup...

Legging Control

Calibration...
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Next, establish  [Tcore M

communication

H DustTrak DR detected on 169.254.241.173
Wlth th € Communications Functioning 0K

instrument
Model Number (8543 Serial Mumber 8543150403
Press the
Discover Instrument Status ||d|a
Instrument
button IP Address 169 . 254 . 241 . 173
Logging Program | LIEE1E81
Select your
desired log
DustTrak DR d d on 169.254.241.173
mOde from the u lgummuniceatl?grgz FS:cliUning ok
Logging

Program dl’Op— Model Mumber 3543 Serial Number 3543150403

down menu.

Instrument Status |Id|e

IP Address 169 . 254 . 241 . 173
Discover Instrument

Logging Program S StartLogging
Stop Logging

Close
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Press Start ("Logging Control

Logging to
begin the
logging.
Model Number
Instrument Status
IP Address

Logging Program

Instrument logging started

8543 Serial Number 2543150403

Fiunning
189 . 254 . 241 . 173
Discover Instrument
[
. [
TEST 5 - |
Stop Logging
Close

If a start date and start time is selected, the instrument will
not immediately start with the logging and will remain in
idle unit the targeted date and time.

Downloading Data

Once the data has been
logged to the instrument, it can
be down loaded into TrakPro
software.

Select File->Receive to

download data from the
instrument.

32
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EI Close Ctrl+M |
| EH save Ctrl+5 |
| Save As...
| B0 Receive... Ctrl+R
Export »
Delete Test
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This will allow
for the
downloading of
some or all of
the data stored
on the
insturment.

-
Receive Tests From Instrument

[S5)

Instrument:  |DustTrak DRX

Serial Mumber:

Select Logged Data Test(s) to Receive: (2]

[0} Date

Time:
TEST1_001 02/02/2015 10:33.55
TEST 5 002 0441572015 070125

Percent Log Memory Available:

f

1a0

2543150403

Select Al

BReceive

Delete

Delete Al

Close

L

Viewing, Graphing and Exporting Data

Read the TrakPro software help files for information on how to view,
graph and export the DustTrak data.

Local Analog/Alarm Output

The DustTrak Environmental Monitor has an Analog/Alarm Output
connection on the side of the instrument.

The pin-outs for wiring are shown below.

Analog Output (+)

Analog Ground (-)

4-pin miniDIN connector

Alarm Positive (+)

Alarm Ground (-)

Cable Wiring Diagram

Brown Wire Analog Ground
Orange Wire Analog Out
Red Wire Alarm (+)
White Wire Alarm (-)

Black Wire Shield

Figure 16: Cable Wiring Diagram
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Wiring the Analog Output
System specifications:

e Output voltage: 0 to 5 VDC. With a maximum output of 15 mA.

e Output Current 4 mA to 20 mA with a maximum load impendence
of 250 ohms.

e Correct polarity must be observed (see pin-outs above).

Wiring the Alarm

System specifications:

¢ Maximum voltage: 15 VDC (DO NOT USE AC POWER)
e Maximum current: 1 Amp

e Correct polarity must be observed (see pin-outs above)

The alarm switch, located inside the DustTrak monitor must be
located on the ground side of the alarm system.

WARNINGS

e The Alarm Output function should not be used to
detect hazardous conditions or to provide an alarm for
protecting human life, health, or safety.

e When connected to the analog out and alarm out

connector, you must use safety certified equipment
and/or power sources.

Caution

The alarm switch must not be wired to AC power! Failure
to install the user alarm properly could damage the
DustTrak instrument and/or void the instrument warranty!
Please read and follow all instructions before wiring or
operating the user alarm.
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Using TrakPro Software to Program the Analog Output

Use TrakPro software to configure the Analog output. Select
Instrument Setup -> Parameters -> Analog Output... to get to the
Analog output dialog.

Instrument Setup | Options  Help
Communications... st Trak DRX

Radio Comm...

Parameters Clock...

Legging Setup... Logging Intervals...

Logging Control Time Constants...

Other...
LCalibration... I
[ Analog Qutput... |
8533104202 Alarm Setpoint...

L]=te kel Nu T belwin}

This dialog will allow for the turning on/off and configuring of the
analog output.

e o
Analeg Qut lﬁ
(@ OFF

Close

Analog Out Settings

| Size Fraction PM1 Upper Limit [mg/m-]
0.000
H
Lower Limit [mg,m?]
Qutput Setting 0-5v 0.000

Analog out [On, Off] Turns analog out port on.

Selects the size channel that will drive
the analog out. DRX Models 8543 or
8543-M only.

Size Fraction

Output Setting [V, mA] | Select 0-5 V or 4-20 mA.

Lower Limit [mg/m3] Mass concentration reading of the
selected channel that will correspond to

0V or 4 mA.

Upper Limit [mg/m?] Mass concentration reading of the
selected channel that will correspond to

5V or 20 mA.
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Using TrakPro Software to Program Alarm Setpoints

Use TrakPro software to setup the Alarm Setpoints. Select
Instrument Setup -> Parameters -> Alarm Setpoint... to get to the
alarm settings dialog.

wstrument Setup | Options Help

Communications... ust Trak DRX

Radic Comm...

Parameters Clock...
Legging Setup... Legging Intervals...
Legging Contral Time Constants...
Qther...
Calibration...
Analog Output...
el Alarm Setpoint...
QR A4
rAIarTns @1

Select program to edit alarm settings

PM2.5 Alarm Alarm Settings
RESP Alarm
PM10 Alarm Alarm Setpoint (ma/m3):
| |TOTAL Alarm 150.000
H
Audible o} @) OFF
| Relay Oon @ OFF I
Send
ILI Visible ON @) OFF 1

[

The Alarm is dependent on the logging interval. For the
DustTrak Environmental Monitor to alarm as soon as the
Alarm Setpoint is exceeded, the logging interval must be
set as low as possible (i.e., 1 second or 2 seconds). If a
long test duration does not permit setting such a short
logging interval, use the STEL alarm instead. The STEL is
always based on 1 second concentrations and is
independent of the logging interval. For more details on
the STEL alarm, see section below on STEL.

In Survey mode, the alarm is dependent on the time
constant.
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Alarms can be set of each mass channel for the DRX Models 8543/
8543-M (PMz1, PM2, Resp, PM1o and Total). Alarms can only be set for
the Total channel for the standard DustTrak Models 8540 /8540-M/

8542-M.

Alarm Setpoint
[mg/m?]

The alarm setpoint is the mass
concentration level upon which the alarml1
is triggered.

Alarm will trigger if the mass concentration,
taken at the logging interval, rises above the
setpoint.

Relay [On, Off]

When the relay alarm is turned on, unit will
close its local relay switch when Alarm level
is surpassed.

Relay alarm can only be linked to one mass
channel at a time for the DRX models 8543/
8543-M.

STEL [On, Off]

When the STEL alarm is turned on, STEL
data will be collected when Alarm level is
surpassed.

STEL alarm can only be linked to one mass
channel at a time for the DRX models 8543/
8543-M.

See following STEL Note.

Audible [On, Off]

When the audible alarm is turned on, the
instrument will activate internal beeper
when the alarm level is surpassed.

Audible alarm can only be linked to one
mass channel at a time for the DRX models
8543/8543-M.

Visible [On, Off]

Not used for the 8540/8540-M /8542-M /
8543/8543-M models.
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STEL Alarm

STEL stands for Short Term Exposure Limit. When a STEL alarm is
selected, the instrument will inspect the data on a second by second
basis, independent from the selected logging interval. If the mass
exceeds the STEL limit, a STEL event triggers and the following

actions will be taken.

Data

Data will be taken of the STEL alarm
channel at a 1 minute logging interval for
15 minutes.

This data will be stored in a separate file
named STEL XXX, where XXX will be
matched to the logged data file.

The instrument will also continue to log the
mass concentration data at the logging
interval selected.

STEL Alarm repeat

If the instrument remains over the STEL
limit after the 15 minute interval, or if the
instrument exceeds the STEL limit later
during the sample period, additional STEL
files will be generated.

STEL Data can be downloaded in TrakPro software similar to the

standard data.
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Chapter 5

Maintenance

The DustTrak Environmental Monitor can be maintained in the field
using the instructions below.

TSI recommends the DustTrak Environmental Monitor be returned to
the factory for annual calibration. For a reasonable fee, TSI will
quickly clean and calibrate the unit and return it to you in “as new”
working condition, along with a Certificate of Calibration. This “annual
checkup” helps ensure that the instrument is always in good
operating condition.

WARNING

The only user-serviceable parts inside the DustTrak
Environmental Monitor are the gravimetric filter, pump,
and sheath flow filter accessible behind the removable
service panel.

The instrument case should only be opened by TSI or
a TSI approved service technician.

To maintain the MCERTS certification, it is required that the
MCERTS model photometers (8540-M, 8542-M, 8543-M) be
recalibrated on a yearly cycle.

Maintenance Schedule

The DustTrak Environmental Monitor requires maintenance on a
regular basis. Table 1 lists the factory recommended maintenance
schedule.

Some maintenance items are required each time the DustTrak
monitor is used or on an annual basis. Other items are scheduled
according to how much aerosol is drawn through the instrument. For
example, TSI recommends cleaning the inlet sample tube after

350 hours of sampling a 1 mg/m? concentration of aerosol. This
recommendation should be pro-rated according to how the instrument
is used. 350 hours at 1 mg/m? is the same amount of aerosol as

700 hours at 0.5 mg/m?® or 175 hours at 2 mg/m?, etc.
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Table 1. Recommended Maintenance Schedule

Iltem | Frequency

Clean the inlet nozzle* 350 hr. at 1 mg/m®*
Replace internal HEPA filter Every 6 months
Return to factory for cleaning and calibration Annually

*Pro-rated, see discussion above.

The DustTrak Environmental Monitor keeps track of the accumulated
amount of aerosol drawn through it since its last cleaning.

Cleaning the Inlet
The inlet should be cleaned based on the schedule in Table 1.

1. Turn the DustTrak monitor off.
2. Remove the 4 screws and the inlet mounting ring.

3. Unscrew the black inlet nozzle from the instrument (Figure 17).

’\Inlet

Nozzle

Figure 17: Unscrew Inlet Nozzle

4. Use a cotton swab to clean the outside of the inlet nozzle body.
You may dampen the swabs with water or a light solvent (e.g.,
isopropanol). Clean the inner diameter of the nozzle by using a
small brush, along with a light solvent. Dry the nozzle by blowing
it out with compressed air, or let it air-dry thoroughly.
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Be careful not to blow particles into the DustTrak
monitor inlet port.

Figure 18: Do NOT Blow into Instrument

5. Screw (hand-tighten) inlet nozzle back into instrument.

Maintenance
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Cleaning and Oiling Impactors

Follow the recommended Impactor cleaning interval for size selective
Impactors as shown below. These impactors are used with models
8540, 8540-M, and 8542-M DustTrak Environmental instruments.

Recommended impactor maintenance interval is every two months
except where the “average dust concentration” level indicated in the
table shows the impactor should be cleaned more frequently:

Average dust Impactor
concentration (mg/m?) maintenance interval
0.015 97 days
0.025 60 days
0.035 42 days
0.050 30 days
0.100 16 days
0.150 10 days
0.250 6 days
0.400 4 days

1. Unscrew Impactor. Check O-ring on the impactor base.

2. Clean outside and inside of Impactor and the impactor plate using
a clean brush and a light solvent. Dry impactor parts by blowing it
out with compressed air, or let it air-dry thoroughly.

3. Apply two drops of oil (included) to the impactor plate. Do not
over-fill impaction plate.

Apply
2 Drops of Ol

TR

Figure 19: Apply Two Drops of Oil to Impactor Plate
4. Screw (hand-tighten) impactor back together.
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Replacing the Internal Sheath Air (HEPA) Filter

Recommended to replace the internal sheath air filter after every six
months of use.

1. Turn the instrument off.

2. Open Instrument Service Panel.

Figure 20: Open instrument service panel

3. Disconnect and remove old sheath air filter from the instrument.

Figure 21: Disconnect and remove old sheath air filter
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4. Replace with new filter (PN 854044). Ensure tubing coming from
the “Y” connects to the inlet side of the filter as indicated by the
Flow arrow.

B v e e

Figure 22: Replace with new filter

5. Replace cover and return to service.

Figure 23: Replace cover

6. Itisimportant to reset the instruments filter change date and
cumulative filter mass concentration after replacing the
Sheath air filter. Resetting the filter concentration may clear the
filter error condition shown in the Data tab of DustTrak Checkout
Software. Reset the date and concentration by performing the
following:

a. Power the instrument.
b. Open the DustTrak Checkout software.

c. Connect the provided USB cable to the instrument and your
personal computer.

d. Click Connect.
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e. Click Reset Filter Date and Concentrations.

& Environmental DustTrak Checkout  2.0.0.0 o[@]=

Connect | Data

Flow | Zero | Laser | Diagnostics ‘ IP Label ‘ IP Addressing

InstiPaddr  169.254.188.53 [ Disconnect |
Serial Number: 8542164901

Model Number: 8542-M

Firmware Version: 3.7

Instrument Time:  12/14/2017 1:35:40 PM | SetlInstrument Date and Time
Calibration Date: 3/24/2017
Filter Change Date: 12/14/2017

Cum Mass: 1.602118 mg Reset Filter Date and Concentrations
Cum Filter Mass: 0 mg
Pump Run Time: 3111 hrs

|

{ Shutdown Instrument |

f. A Dialog box will appear confirming that you would like to
reset the change date and the cumulative concentration. Click
Yes to reset the cumulative filter concentration to zero.

Env DustTrak Checkout £

Are you sure you want to reset the filter change date and clear the cumulative
concentrations?

g. The Checkout software will now show, zero for the Cum
Filter Mass Concentration and the current date for the Filter
Change Date.
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Replacing Pump
If the pump stops working it can be removed and replaced in the field.

See Quick Start Guide included with Replacement Pump (854043) for
additional details.

Figure 24: Replacement pump (854043)

First remove Photometer from the Environmental Enclosure following
the applicable steps:

1. Disconnect all cabling from photometer.

2. Remove inlet column. If inlet column includes a heated inlet,
remove ferrite from the heated inlet cable and carefully pull the
heated inlet cable through the key hole on the mounting ring
when removing the inlet column (Figure 25a).

3. Loosen retainer ring on top of enclosure while holding photometer
(Figure 25b).

4. Pull photometer down and out of enclosure.

Figure 25: (a) Heated inlet cable;
(b) remove retainer ring and lower photometer

46 Chapter 5



5. Have a replacement pump (P/N 854043) available.

6. Open instrument service panel.

o

Figure 26: Open instrument service panel

7. Remove the four Phillips head screws from the left-side panel.

7
¥l
E

o

Figure 27: Remove screws from left side panel

Remove only the raised-head screws. DO NOT remove
any screws with heads flush to the surface.
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8. Pull the pump from the enclosure and detach tubing, muffler, and
cable.

Figure 28: Pull pump from enclosure and
detach tubing, muffler, and cable

9. Attach the muffler to P, tubing to V, and cable to the new pump.

Figure 29: Attach muffler

10. Orientate pump inside instrument with muffler (port P) located in
the lower position (Figure 30).
~—

Figure 30: Pump orientation
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11. Secure the new pump inside the instrument case with the four
Phillips head screws.

Figure 31: Secure new pump

12. Replace photometer service panel and reinstall photometer
inside Environmental Enclosure following the steps above in
reverse order.

Replacing Internal 37-mm Sampling Cassette

The internal 37-mm sampling cassette can be used to conduct
sampling for gravimetric or analytical analysis. The instrument comes
with a blank cassette containing a mesh sieve to keep large
particulate out of the instrument pump. Save this cassette and the
filter. The DustTrak Environmental Monitor is designed to have this
cassette in place. The flow path will be compromised without this
cassette.

On occasion, this cassette should be removed and the mesh screen
cleaned by blowing with compressed air or rinsing under running
water and allowing the filter to dry before replacing the cassette. The
maintenance interval will vary depending on the aerosol concentration
being sampled. TSI recommends initially checking this screen
monthly until the accumulation rate is understood. The screen should
be changed out before it is completely coated with aerosol buildup.

TSI does not provide the filter media for gravimetric or analytical
sampling. When requesting cassette with filter media for gravimetric
sampling, ask for a 37-mm, 2-piece, static conductive plastic cassette
to ensure proper fit inside the DustTrak monitor.
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1. Toremove cassette, open instrument service panel to access the
sampling cassette. Internal sampling cassette is located in the
upper right opening.

Figure 32: Remove sampling cassette

2. Pinch the blue clip to release the bottom cassette holder and
remove cassette from the holder.

o
I_}

e oy yow

Figure 33: Release and remove cassette holder
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3. Inspect top inlet fitting and blue cassette holder for broken pieces
or missing seals.

Figure 34: Inspect top inlet fitting and blue cassette holder

4. Install a blank cassette for DustTrak monitor operation or a pre-
weighed, 37-mm, 2-piece, conductive cassette with the
appropriate filter media for the analysis to be performed.

5. Make sure the Cassette snaps securely into the inlet port on the
top of the cassette holder and the bottom clip snaps securely into
place. If the connection is loose, air will leak resulting in
inaccurate sampling results.

Figure 35: Snap cassette securely into inlet port
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Return Shipping to TSI

Visit our website at http://rma.tsi.com to initiate a Return Merchandise
Authorization (RMA) form:

e Disconnect and remove all accessories.

e Package the instrument in the original shipping container.

If original shipping container is not available, pack
instrument securely in a durable shipping carton to
prevent damage during shipment. Consult with courier for
packing guidance.

¢ Include printed copy of RMA form inside container with
instrument.

e Ship to TSI via trackable shipping method.
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Chapter 6

Troubleshooting

The table below lists the symptoms, possible causes, and
recommended solutions for common problems encountered with the

DustTrak monitor.

Symptom
Erratic reading.

| Possible Cause

| Corrective Action

Leak Check connections for leaks
Dirty inlet port and/or | Clean inlet port. Clean or
sample tube replace tubing

Internal filter(s) not
installed properly

Inspect internal filter wells to
make certain the filters and

(leaking) O-rings are seated properly.
Replace internal filters if
necessary
DustTrak Zero Drift Increase autozero
reading frequency
negative
concentrations

Analog output
does not work

Cable/connector not
correctly installed

Make sure cable connector
is fully seated

Output wired with
reverse polarity

Make sure analog out (+)
and analog ground (-) are
wired correctly to data-
logger

Alarm output

Alarm function not

Turn the alarm function on

does not work turned on in TrakPro software
Alarm does not | Alarm setting Check the alarm settings in
turn on correctly | incorrect TrakPro software

Alarm output wired
with reverse polarity

Alarm wires are polarized.
Voltage input must be wired
to alarm input (+)




Symptom
Instrument does

not store new
data

| Possible Cause
Memory is full

| Corrective Action

Delete or transfer historic
data

Instrument is in
Survey mode

The instrument does not
store data in survey mode.
Can to manual or program
log mode

Flow Error is
indicated in
Data set or on
Environet

Flow obstruction

Remove obstruction if still
present. Press any key to
bypass

Internal pump failing,
indicated by inability
to adjust flow rate to
full range

Replace pump per
instructions in maintenance
section

Filter Cassette
clogged or has mass
loading

Replace the filter cassette.
See the maintenance
section of the manual

Laser Error
indicated in data

Laser background is
too high

Remove and clean inlet
nozzle. Pay close attention

set of on to the tip of the nozzle that

Environet is inserted into the
instrument to ensure it is
clear of any contamination

Laser is failing Factory service may be

required

Filter Error Filters need to be Replaced the filters per

indicated in data | replaced instructions in the

set or on maintenance section of this

Environet manual. Make sure to reset

the filter mass and date
once the filters have been
changed

This is only a warning. The unit will continue to operate normally until
the increase in pressure drop across the filter is so high that the pump
can no longer maintain the set flow rate.
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Appendix A

Specifications

Specifications are subject to change without notice.

8540/8540-M /8542-M /8543 /8543-M DustTrak Environmental

Monitors are designed to operate inside a weather-proof enclosure,
like TSI Model 854030 Environmental Enclosure, sold separately.

Sensor Type 90° light scattering

Range 0.001 to 400 mg/m® (models 8540,
8540-M, & 8542-M)
0.001 to 150 mg/m® (models 8543 &
8543-M)

Resolution +0.1% of reading or 0.001 mg/m?3,
whichever is greater

Zero Stability +0.002 mg/m? 24 hours at 10 sec time

constant

Particle Size Range

Approximately 0.1 to 10 um (8540,
8540-M, 8542-M) / 0.1 to 15 pm (8543,
8543-M)

Flow Rate

3.0 L/min set at factory

Flow Accuracy

+5% factory setpoint
Internal flow controlled

Temperature +0.001 mg/m? per °C
Coefficient

Operational Temp 0°to 50°C

Storage Temp -20° to 60°C

Operational Humidity

0-95% RH, non-condensing

Time Constant

Adjustable 1 to 60 seconds

Data Logging

45 days at 1 minute samples

Log Interval

1 second to 1 hour

Physical Size (HWD)

8.25x8.25x4.25 in.
(20.96 x 20.96 x 10.80 cm)

Weight

5.25 Ibs (2.38 kg)
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Communications Cellular, Wi-Fi, GPS/GPRS, USB (Host
and Device) and Ethernet.

Power 12/24 Volts DC
50 Watts

Analog out 8540/8540-M/8542-M /8543 /8543-M:
User selectable output 0 to 5 V or 4 to
20 mA

User selectable scaling

Alarm Out 8540/8540-M /8542-M /8543 /8543-M:
Relay or sound buzzer
Relay

No latching MOSFET

User selectable setpoint

5% deadband

Connector 4-pin, Mini-DIN connectors

Internal Sampling Removable 37-mm, 2-piece, static
Cassette conductive cassette.

Contact AIHA Accredited Analytical Lab for
guidance on selecting the proper filter
media for your desired analytical testing.
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Appendix B

Instrument Command Set

See the DustTrak Communication Manual for instrument command
instructions for communicating with wireless modems and other
dataloggers. Contact TSI for a copy of the communication manual
(P/N 6002481).

Connecting to the Instrument

USB and Ethernet instrument connections use the NDIS
communication method, port 3602.

NIDS Communication Method

This method communicates with the instruments via USB and
Ethernet connections. This method uses windows sockets.
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Appendix C

DRX Advanced Calibration

The advanced calibration method is employed to yield high size
segregated mass concentration accuracy for PM, o, PM, s,
Respirable, and PMy, size fractions. It involves two gravimetric
measurements to obtain PCF and SCF. The two gravimetric
measurements can be done in sequence or in parallel, depending on
the gravimetric sampling device availability.

Option 1: Serial Gravimetric Calibration

When you have only one set of gravimetric sampling devices, the
DustTrak DRX advanced calibration can be performed in two serial
steps. The experimental setup is in Figure 36a. The calibration steps
are outlined below:

Step 1: PCF Calibration

e Install a PM, 5 impactor at the inlet of the external gravimetric
filter.

e Co-locate and run the gravimetric sample and DustTrak DRX
monitor simultaneously to collect enough mass on the gravimetric
filter.

e Calculate the PM, 5 mass concentration (PM; 5 ray) from the
gravimetric filter based on the net mass collected on the filter,
sampling time, flow rate, and total liters of air sampled.

¢ Read the DustTrak DRX monitor average PM, 5 mass
concentration (PM, 5 prx) from the screen or through TrakPro
Data Analysis Software.

e Calculate the new PCF

F,M2.5_Grav

PCFNeW= PM xPCFo|d.

2.5 DRX
e Update the new PCF in user calibration settings.

Step 2: SCF Calibration

¢ Install a PMyq impactor at the inlet of the external gravimetric
filter.
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e Co-locate and run the gravimetric sample and DustTrak DRX
monitor simultaneously to collect enough mass on the gravimetric
filter.

e Calculate the PM4o mass concentration (PMyq_gay) from the
gravimetric filter based on the net mass collected on the filter,
sampling time, flow rate, and total liters of air sampled.

e Read the DustTrak DRX monitor average PM, 5 (PM2 5 prx) and
PM;o (PM1o prx) Mass concentration from the screen or though
TrakPro Data Analysis Software.

e Calculate the new SCF

-

PM1o_Grav — PM25 prx

3
SCFNeW= ( > xSCFom.

PM1io prx — PM25 prx

e Update the new SCF in user calibration settings.

Option 2: Parallel Gravimetric Calibration

When you have two sets of gravimetric sampling devices, the
DustTrak DRX monitor advanced calibration can be performed in the
parallel configuration as shown in Figure 36b. The calibration steps
are outlined below:

1. Install a PM, 5 and a PM,q impactor at the inlet of the two external
gravimetric filters, respectively.

2. Co-locate and run the gravimetric samples and DustTrak DRX
monitor simultaneously to collect enough mass on the gravimetric
filters.

3. Calculate the PM; 5 (PM; 5 ray) and PMyo (PMyg gray) Mass
concentrations from the gravimetric filters based on the net mass
collected on the filter, sampling time, flow rate, and total liters of
air sampled.

4. Read the DustTrak DRX monitor average PM, s and PM;, mass
concentration (PM; 5 prx and PMyo prx) from the DRX screen or
through TrakPro Data Analysis Software.

5. Calculate the new PCF

PIV|2.5_Grav

PCFNew= P XPCFO|d ,

M2.5_DRX
and the new SCF

— 3
|:>M1O_Grav PMZ.S_Grav) xSCFOId-

SCFew= (PMm_DRx ~PMas orx
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6. Update the new SCF and PCF in the user calibration settings.

Aerosol Source

First PM.s Impactor
then PMy, Impactor

DUSTTRAK DRX
————————— Filter

To Flow Control
and Vacuum

Aerosol Source

l

PM1o PMZ.S
Impactor Impactor

DUSTTRAK DRX
_________ Filter [-------1Filter

l l

To Flow Control To Flow Control
and Vacuum and Vacuum

Figure 36: Experimental Setup for
(a) Serial and (b) Parallel Gravimetric Calibration

DRX Advanced Calibration

(@)

(b)
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Index

4
4-pin miniDIN connector, 33

A

advanced calibration, 59
advisory labels, vi
alarm
alarm setpoint, 37
audible, 37
logging interval, 36
relay, 37
STEL, 37
survey mode, 36
visible, 37
wiring, 34
alarm out, 56
alarm output function
warning, 34
alarm output not working, 53
alarm setpoint, 36, 37
ambient cal, 26
analog
lower limit, 35
out, 35
output setting, 35
size fraction, 35
upper limit, 35
analog out, 56
analog output
configuring, 35
wiring, 34
analog output not working, 53
analog output settings, 35
analog/alarm output
connecting, 33

applying drops of oil to impactor plate,
42

attaching muffler, 48
audible, 37

auto start on power up, 24
auto zero check, 13

auto zero interval, 25

B

back panel interface control
dimensions, 9

back panel with mounting holes, 9

base, 13

battery power, 12

bubble buret, 17

C

cable

detaching, 48
cable wiring diagram, 33
calibration certificate, 6
calibration factor

for specific aerosol, 28
calibration label, vi
cassette holder

removing, 50
caution

description, vii
caution and warning symbols, vii
cellular, 56
checkout application, 16

connect tab, 16

data tab, 16

diagnostics tab, 19

IP addressing tab, 20

IP label tab, 19

setup screen, 15

zero tab, 18
checkout application screen, 15
checkout calibration

flow tab, 17
Class I, v
cleaning

inlet conditioner, 40
cleaning impactors, 42
communications, 56
connect tab, 16
connecting

analog/alarm output, 33
connecting computer, 21
connection rings, 13

D

data logging, 55

data tab, 16

description of caution/warning
symbols, vii

detaching cable, 48

detaching muffler, 48

detaching tubing, 48

determining calibration factor for
specific aerosol, 28

diagnositcs tab, 19

diagnostics tab, 19

discover instrument, 31

dry piston, 17

DustTrak checkout software, 14
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DustTrak DRX Environmental Monitor,

5

DustTrak DRX Environmental
Monitors, 1

DustTrak Environmental Monitor, 5
checkout application, 16

DustTrak Environmental Monitors, 1

E

engineering mode, 18

Environet, 14

Environmental Enclosure, 7, 11

erratic reading, 53

error messages, 53

Ethernet, 56

European symbol for non-disposable
item, vi

exporting data, 33

F

factory cal, 26
features, 8
filter cassette
troubleshooting, 54
filter error, 54
flow accuracy, 55
flow error, 54
flow measurement devices, 17
flow rate, 55
flow setpoint
factory setting, 17
flow tab, 17

G

GPS, 56

graphing data, 33
gravimetric analysis, 28
gravimetric sampling, 29

H

heated inlet cable, 46
heated inlet sample conditioner, 7
heater enclosure, 12
HEPA filter, 43
humidity, 55
1-J-K
inlet, 13
inlet conditioner
cleaning, 40
inlet fitting, 51
inlet nozzle, 40
instrument calibration
user calibration name, 27
instrument command set, 57
connecting to instrument, 57
NIDS communication method, 57
instrument not storing new data, 54
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instrument setup, 14
calibration, 26
logging control, 30
parameters
alarm setpoint, 36
clock, 25
internal gravimetric filter, 30
internal sampling cassette, 56
removing, 50
replacing, 49
internal sheath air filter
replacing, 43
IP addressing tab, 20
IP label, vi
IP label tab, 19

L

laser error, 54

laser radiation label, vi
laser safety, v

laser tab, 18

last zero, 18

log interval, 24, 55

log modes, 23

logging control, 30
logging setup, 22
lower limit, 35

M

maintenance, 39
schedule, 39
maintenance schedule
cleaning and calibration, 40
recommended, 40
manual, 6
manual log, 23
manual mode
log interval, 24
test length, 24
time constant, 24
mass flowmeter, 17
maximum current, 34
maximum voltage, 34
MCERTS certification
EDTDRXM, 3
EDTPM10M, 2
EDTPM2.5M, 3
MCERTS certification label, vi
Model 8540, 1, 5
alarm, 37
Model 8540-M, 1, 5
alarm, 37
maintaining certification, 39
Model 8542-M, 1, 5
alarm, 37
maintaining certification, 39
Model 8543, 1,5
alarm, 37
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Model 8543-M, 1, 5 program log options (cont.)

alarm, 37 test length, 24
maintaining certification, 39 time between tests, 24
monitor time constant, 24
maintenance, 39 use start date, 24
specifications, 55 use start time, 24
troubleshooting, 53 pump, 6
muffler securing, 49
attaching, 48 pump orientation, 48
detaching, 48 R
N range, 55
name, 28 read button, 23
negative concentrations, 53 reference flowmeter, 17
Netronix Thiamis 1000 communication relay, 37
node, 7 release cassette holder, 50
Netronix Thiamis communication replacement pump, 46
node, 14 replacing cover, 44
new zero, 18 replacing internal sampling cassette,
newcal, 30 49
NIDS communication method, 57 replacing internal sheath air filter, 43
number of tests, 24 replacing new filter, 44

replacing pump, 46

O reset filter date and concentrations, 45
oiling impactors, 42 resolution, 55
omni-directional inlet column, 13 retainer ring, 46
omni-directional inlet with water trap, 7 return shipping to TSI, 52
operating options, 14 reusing and recycling, viii
operational temp, 55 rotameter, 17
optical particle counter, 1
optional accessory 854040, 13 S
output setting, 35 safety information, v
sampling mode options, 23

P-Q SCF calibration, 59
parallel gravimetric calibration, 60 securing pump, 49
particle size range, 55 sensor type, 55
parts identification, 5, 8 serial gravimetric calibration, 59
PCF calibration, 59 serial number label, vi
photometric calibration factor, 28 service policy, ii
PM,, impactor, 8 set user calibration factor, 27
PM10 and PM2.5 indicative setting up, 11

certification, 3 instrument, 14
PM,, impactor, 8 setting user calibration factors, 26
PM10 indicative certification, 2 sheath air filter, 6, 43
PM s impactor, 8 size calibration factor, 28
PM2.5 indicative certification, 3 size fraction, 35
power, 56 software, 5
power button, 14 installation, 21
power connector pin-out, 12 software link, 15
power supply, 5, 7, 12 solar power supply, 12

Thiamis accessory warning, 12 specifications, 55
product overview, 1 standard calibration method-
program log options, 24 photometric calibration factor, 28

auto zero interval, 25 start logging, 32

log interval, 24 start zero, 18

log name, 24 static conductive cassette, 6

number of tests, 24
start date, 24
start time, 24
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STEL, 37, 38
alarm repeat, 38
data, 38
storage temp, 55
supplying power, 12
survey mode, 16, 23
auto start on power up, 24
time constant, 24

T

temperature coefficient, 55

test length, 24

time between tests, 24

time constant, 24, 55

TrakPro software, 13
communicating with instrument, 22
configuring logging parameters, 22
installation, 21
program alarm setpoints, 36
program analog output, 35
quick reference, 21
steps, 22

troubleshooting, 53

tubing
detaching, 48

U

unpacking, 5
upper limit, 35
USB, 56

USB cable, 5
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USB port
connector, 21

use start date, 24

use start time, 24

user cal, 26, 28

user calibration
name, 28
photometric calibration factor, 28
size calibration factor, 28
user cal, 28

user calibration factors, 26

\Y

viewing data, 33

visible, 37

W-X-Y

warning, v
description, vii

warranty, i

water bottle, 13

water trap bottle, 8

weight, 55

WiFi, 56

wiring alarm, 34

wiring analog output, 34

z

zero calibration, 13
zero stability, 55
zero tab, 18
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